Operation Guide
Version 2.0

Supports Windows XP, Vista, and Windows 7
Requires ESRI ArcMap® Software version 9.2 or greater

Revised 10-08-2010
Terms of Use

This manual and the software described herein are furnished under license, and are subject to a license agreement. The software may be used only in accordance with the terms and conditions of the agreement.

No part of this manual may be reproduced or transmitted in any form or by any means electronic, mechanical, or otherwise, including photocopying and recording – without prior written permission of Wind Environmental Services, LLC.

We have made every effort to ensure the accuracy of the material provided herein; however, the publishers and authors assume no responsibility whatsoever for the uses made of this material or for decisions based on its use. Further, we make no warranties, either expressed or implied, regarding the contents of this product or its fitness for any particular purpose. Neither the publisher nor anyone else who has been involved with the creation, production, or delivery of this material shall be liable for any reason.

If you have any comments or suggestions concerning this manual, please forward them to Wind Environmental Services, LLC. Information in this manual is subject to change without notice.
Table of Contents

INTRODUCTION TO WIND IMAGE™ FOR ARCMAP® ........................................................................................................... 4

WIND IMAGE™ INSTALLATION, LICENSING AND REGISTRATION ......................................................................................... 4

WIND IMAGE™ WORKFLOW OVERVIEW ........................................................................................................................... 9

HOW TO USE WIND IMAGE™ ............................................................................................................................................... 10

WIND IMAGE™ APPLICATION COMPONENTS – ILLUSTRATED ........................................................................................................... 10

About the Wind Image™ Toolbar ........................................................................................................................................ 10

Main Application Menus .................................................................................................................................................. 11

Create Feature Class or ESRI® shp file from Geotagged Imagery Window ........................................................................... 12

Wind Image™ Editor ............................................................................................................................................................. 12

Editor Menus .................................................................................................................................................................... 13

Wind Image™ Editor – EXIF Data Display Panel ................................................................................................................ 14

Wind Image™ EXIF Editor .................................................................................................................................................. 14

Wind Image™ Imprint Window ............................................................................................................................................... 15

RECORDING GEOTAGGED IMAGERY – GUIDANCE & RECOMMENDATIONS ........................................................................... 15

LOAD IMAGES INTO WIND IMAGE™ ..................................................................................................................................... 16

About Loading Images .......................................................................................................................................................... 16

How to Load Images into Wind Image™ ................................................................................................................................ 16

PREPROCESS YOUR IMAGES .................................................................................................................................................... 18

About Preprocessing Your Images ......................................................................................................................................... 18

Using the Wind Image™ Editor ........................................................................................................................................... 18

IMPRINTING IMAGES ............................................................................................................................................................. 24

GENERATE IMAGE-INTEGRATED FEATURE CLASSES OR ESRI® SHP FILES ........................................................................... 26

How to Generate an Image-Integrated Feature Class or ESRI® shp file ................................................................................ 26

How to Append to an Existing Image Integrated Feature Class ............................................................................................ 27

IMPORT A RICOH TRACKLOG OR A GARMIN GPX WAYPOINT FILE .................................................................................... 29

About Importing a GPS Tracklog or a Garmin Waypoint File ................................................................................................ 29

How to Import a GPS Tracklog ............................................................................................................................................... 29

How to Import a Garmin GPX Waypoint ................................................................................................................................ 30

DYNAMICALLY VIEW IMAGES IN ARCMAP® ........................................................................................................................ 31

About Dynamically Viewing Images in ArcMap® .................................................................................................................. 31

How to Dynamically View Images in ArcMap® .................................................................................................................... 31

How to Open Wind Image™ Editor from the ArcMap® Interface ............................................................................................ 31

MAP YOUR IMAGES ............................................................................................................................................................... 32

About Importing CartoPac® Data ............................................................................................................................................... 32

About Importing ArcPad® or TerraSync® Data ........................................................................................................................ 33

How to Convert Image Thumbnails to Graphics .................................................................................................................... 32

ABOUT IMPORTING CARTOPAC® DATA ..................................................................................................................................... 33

About View Carto-Pac data sets using the ‘Show Photo’ tool ................................................................................................ 33

How to Convert a CartoPac data-set to a Raster-Embedded data-set ..................................................................................... 33

How to Convert CartoPac data-set to a Shapefile.................................................................................................................... 33

IMPORTING DATA FROM ARCPAD® OR TERRASync® .............................................................................................................. 34

About Importing ArcPad® or TerraSync® Data ........................................................................................................................ 34

How to Convert Imported data to a Raster-Embedded data set ............................................................................................. 34

ADDITIONAL RESOURCES ...................................................................................................................................................... 35
Introduction to Wind Image™ For ArcMap®

Thank you for purchasing a copy of Wind Image™ For ArcMap®

The Wind Image™ extension for ArcMap® provides a set of advanced tools that speed the integration of geotagged imagery within ArcGIS® by automating the conversion of raw geotagged images into image-aware feature classes¹ that display within ArcMap®. During the conversion process, Wind Image™ automatically creates a point at the geotagged location for each image and associates its image via a hyperlink, or by embedding the image directly into the attribute table of the feature class. Wind Image™ literally allows you to put your images less than one click away within the ArcMap® environment. It has never been easier to map and visualize geotagged image location within the ArcMap® environment.

Wind Image™ also provides a number of additional functions designed to enhance your image collection, mapping, and sharing efforts. For instance, with Wind Image™ you can graphically edit each image in numerous ways, directly edit EXIF information, load track logs and GPX files that record travel paths, as well as view and map images within ArcMap® once you have imported them. Wind Image™ also gives you the option to auto-imprint your images with their corresponding coordinates, date, time, company or agency logos and several other useful tags.

Wind Image™ can work with all the major ArcGIS® data formats including Shapefile, Personal Geodatabase®, File Geodatabase®, and ArcSDE® formats.

Wind Image™ For ArcMap® truly is the best way to integrate GPS camera technology, with ESRI ArcGIS® software.

Wind Image™ Installation, Licensing and Registration

Currently we offer Wind Image™ with single use licensing. This means that you must have one license for each machine on which you want to use it. You must register each copy of the Wind Image™ extension that you install using the instructions under the “Registering Wind Image” section below.

Installing Wind Image™ on a Windows® Machine

Before you can use the Wind Image™ extension for ArcMap®, you will need to install and register the software. To install the software follow these steps:

1. Insert the Wind Image™ disk media.
2. Double click the new Wind Image™ installation file.
3. Follow the prompts to install.

¹ A feature class specifically designed to map the location of images within GIS, record and make accessible information about each image, as well as set up one or more simplified methods for accessing and working with the images directly from a GIS interface.
Registering Wind Image™

Request Wind Image™ License File

1. Once you have installed the Wind Image™ extension, open ArcMap and click on the Wind Image™ menu pull down and select “Register”.
   (Note: If you do not see the Wind Image toolbar right click in the grey area at the top of ArcMap and right click then check the box next to Wind Image.)

2. Next click on “Purchase Wind Image”.

3. On this screen you will need to create a Login Account. Fill in the lower fields and click “Next”.

4. Next Locate your CD key located inside of your CD case.

Wind Image CD Key
(Required For Registration)
9JWT-1234-DU1A-ABCD
See Registration guide for help located on the install CD
5. On the next screen enter the CD key into the field and click “Ok”.

![Register Wind Image]

6. On the “Purchase Wind Image” screen, simply click “Next”. This will take you to the Wind Image ™ registration server.

![Purchase Wind Image]

7. Your CD key will be automatically entered into the form. Now enter all other requested information and click “Next” again.

8. Verify your registration information is entered correctly and enter any comments and click “Place Order” to submit your license request.
Saving Wind Image™ License File From Registration Server

1. To register your software click “Download ArcMap Registration File” and save the file to your desktop.
2. Once you have downloaded your license file, open ArcMap and click on the Wind Image™ menu pull down and select “Register”.
   (Note: If you do not see the Wind Image toolbar right click in the grey area at the top of ArcMap and right click then check the box next to Wind Image.)

3. Next click “Browse” and navigate to your license file (saved on your desktop).

4. Your software should now be registered.

Registering Wind Image™ License File From Email

5. In the email received from the Wind Image license server right click on the WindImageAM.lic file and select “save file as” and save it to your computer’s desktop.
6. Once you have saved your license file, open ArcMap and click on the Wind Image™ menu pull down and select “Register”.
   (Note: If you do not see the Wind Image toolbar right click in the grey area at the top of ArcMap and right click then check the box next to Wind Image.)
7. Next click “Browse” and navigate to your license file (saved on your desktop).

8. You can now verify you have successfully registered Wind Image™ by opening the main processing application by clicking on the Wind Image™ logo on the toolbar once the application is open click the “Help” then “About” to view your registration information.

9. Be sure to save the email with your license code in a safe place so you will have it in the event you need to re-install the extension at a later date.
Wind Image™ Workflow Overview

Example Workflow

While each photo collection project is unique, you will find that most will follow the basic workflow outlined below.

1. **Record geotagged images** with a GPS enabled camera that records coordinate information (and optionally attribute information) in the EXIF header of the images.

2. **Load images** into Wind Image™.

3. **Preprocess your images** with the Wind Image™ Editor tool - for instance, you can add redlining, adjust contrast, apply a filter, modify information stored in the EXIF header, and much more. (Optional)

4. **Generate an image-integrated feature class** using the Wind Image™ extension and the image locations stored in each image’s EXIF metadata.

5. **Import a Ricoh Tracklog or Garmin GPX Waypoint file** with the Wind Image™ GPS tracklog/waypoint import tool.

6. **Imprint Data and Graphics** onto your images.

7. **Dynamically view images** in ArcMap® using the Wind Image™ show photo tool.

8. **Map your images** with the special mapping tools available in Wind Image™ that streamline the incorporation of images within digital and paper mapping output.

You can use the above workflow as a general guide while you work on your geophytes collection and mapping projects. The following sections will explore each of these steps in further detail. The sections include general explanation, as well as step-by-step instructions and illustrations covering the seven steps outlined above. The sections will thoroughly cover the wide array of functionality that comes with the Wind Image™ extension for ArcMap®.
How to Use Wind Image ™

Wind Image ™ Application Components – Illustrated

The following diagrams illustrate the various application components of the Wind Image ™ extension for ArcMap®. You may find it helpful to refer back to the diagrams in this section as you try to understand topics and instructions discussed elsewhere in the manual.

About the Wind Image ™ Toolbar

1. If you click on the Wind Image ™ Toolbar, you will get the following options.

2. From here you get a variety of options to choose from. You can import a Ricoh Tracklog or a Garmin GPX Waypoint file, convert a Feature Class to Raster, Raster to a Shapefile, or change the Wind Image ™ settings – as well as extend your license and re-register.

3. In the Help section, you can check for updates, Email a Log File *, open the Settings Folder *, etc.

4. In the Settings window, you can change the Thumbnail size and the Image Compression Quality – great for compressing large pictures where great detail is not needed.

(* used for trouble shooting should you need technical support)
The Wind Image ™ Main Application Window

Main Application Menus

- File
  - Browse...
  - Exit
- Image(s)
  - Select All
  - Select None
  - Sort
  - Rotate
  - Delete
  - Create
- Help
  - Visit Website
  - Purchase
  - Register
  - About...

Image(s) found in selected directory will automatically display in this window.
Create Feature Class or ESRI® shp file from Geotagged Imagery Window
You will use this window to generate a new feature class, or to append new image point features to an existing feature class. In addition you can also generate ESRI® shp files in this window. You can launch it from the Wind Image™ main application window by clicking the create command button, or by selecting create from the “Image(s)” menu.

Wind Image™ Editor
Wind Image™ Editor – EXIF Data Display Panel

EXIF Information displayed after selecting “Show” in the EXIF Menu.

Wind Image™ EXIF Editor

The EXIF editor allows you to edit the EXIF information embedded in the image file.
Wind Image™ Imprint Window
The Imprint Window allows users of all skill levels to imprint text, logos, image EXIF tag data and more.

Recording Geotagged Imagery – Guidance & Recommendations
In order to take advantage of the useful functions in the Wind Image™ Extension For ArcMap®, you must record your images with technology that can embed coordinate (and optionally attribute) information in each image’s EXIF header. We recommend the Ricoh 500SE® GPS ready camera. The Ricoh 500SE® is an excellent camera that instantaneously tags pictures with a GPS location, Compass direction, and can also include multiple fields of attribute information in the image EXIF data. However, Wind Image™ can also work with any image as long as the image EXIF includes geographic location information in the proper format. In addition users can enter GPS information into any picture using the EXIF editor in Wind Image™ (See the Wind Image™ Editor section in this manual)

There are a number of ways to tag images with geolocation information, the details of which are beyond the scope of this manual. We recommend using the internet to find more detailed information on the subject.
Load Images into Wind Image™

About Loading Images
Once you have collected one or more geotagged photos in the field, you can begin using the Wind Image™ extension to bring your photos into the ESRI® GIS system.

How to Load Images into Wind Image™

1. Start Wind Image™ by clicking the button on the Wind Image™ toolbar, which will start the Wind Image™ main application window as shown below.

2. If a browse window does not automatically open, click the browse button to open a browse window.
3. Browse to the directory that contains the images you want to process.
   Note: This folder can be on any accessible drive connected to your computer including SD cards that are connected with a compatible SD card reader.
4. Now you will see your images in the Wind Image™ main application window as shown below.

5. Hover over any image with the mouse pointer to show its GPS and EXIF data.

At this point, you may select images to rotate, delete, browse to a new folder containing images, edit, create new image-integrated feature classes, etc. You can even sort the images by their Name, Date, File Size, and Ricoh Memo fields.
Preprocess Your Images

About Preprocessing Your Images
Before using Wind Image™ to create an image-integrated feature class you may want to edit your images or modify EXIF information. Wind Image™ makes it possible for you to perform a host of edits that it permanently saves within each image file in the EXIF header. For instance, you may want to outline an important part of a photo, or manually adjust a geographic coordinate or attribute stored with the image. Wind Image™ makes it possible to make both these changes and more.

Using the Wind Image™ Editor
The Wind Image™ editor is the tool that allows you to edit your images directly. It can edit images in three fundamental ways. These include: 1) Adding new shapes and text directly onto the image, 2) Applying global commands – such as filters and effects, rotate, and flip – that affect the entire image, 3) Show and edit the EXIF information stored with the image. The editor also has several functions that further help you explore and work with your image, such as the magnifier, pan, zoom, and print commands.

Opening the Wind Image™ Editor
1. To open the Wind Image™ Image editor, simply double click on the image you want to edit in the Wind Image™ main application window. (See Editor example below)
Exploring the Wind Image™ Editor

Once the Image Editor opens, you will notice there are five command menus: **Edit**, **Image**, **Draw**, **Commands**, and **Exif**. There are also eleven tools displayed: save, undo, redo, arrow, rectangle selection, ellipse selection, pan, magnifier, zoom, zoom selection, and print.

**The Edit Menu**

- The **Edit** menu contains the following commands:
  - **Undo**: You may use this to undo any changes you make to an image prior to saving your changes. Once you save changes, they cannot be undone.
  - **Redo**: You may use this to redo the last item that you undid.
  - **Cut**: Cut and place things on the Windows clipboard.
  - **Copy**: Copy things onto the Windows clipboard.
  - **Paste**: Paste things onto the image from the Windows clipboard.
  - **Options**: Set basic program options. For details about each setting simply click on the field to view a description at the bottom of the form.
The Image Menu

- The **Image** menu contains the following commands:
  - **Information**: Displays information about the image you are currently editing.
  - **Change Pixel Format**: Opens a window with several settings that allow you to adjust the pixel format of the image.
    - *Tip*: To find out more about each setting click on the setting field and additional help information will display at the bottom of the form.
  - **IPTC Data**: Displays IPTC data.
    - *Note*: Together, the Newspaper Association of America (NAA) and the International Press Telecommunications Council (IPTC) have designed a model to store multiple types of data (metadata) in an image. This metadata is commonly known as IPTC. Adobe Photoshop, along with many members of the newspaper and press industry, use IPTC to store information in images.
  - **Zoom**: Allows you to zoom the image to set scale ranges.

The Draw Menu

The draw menu contains commands that allow you to draw shapes and add text directly onto the image. This can be particularly useful if you want to highlight something about the image or provide explanatory text that will show up every time someone views your image.

- The **Draw** menu contains the following commands:
  - **Line**: Draw a line.
  - **Lines**: Draw multiple lines at once.
  - **Rectangle**: Draw a rectangle.
  - **Ellipse**: Draw an ellipse.
  - **Polygon**: Draw a polygon.
  - **Freehand**: Draw freehand lines.
Text: Add text.

Set Text Back Color: Sets the color that will show up behind any text placed on the image using the add text command.

- Tip: By default, the text will show up in the upper left hand corner of the image. However, if you use the selection tools to select an area of the image prior to activating the text command, the text will appear within the selected area.

Clear Text Back Color: Clears any previously set text backing color.

The Commands Menu

The Commands menu contains functions that apply a wide range of image modifications and manipulations. Typically, these functions apply to the entire image, but you can also apply them to portions of the image by applying a selection to the image prior to using one of the commands functions. The Commands menu functions provide you with a great deal of flexibility in the way you prepare your images.

- The Commands menu contains the following commands:
  - Channels: Groups the following color space commands together:
    - Adjust: Adjust RGB values
Note: RGB color space defines colors three individual grayscale channels: one each for red, green, and blue. Each of these defines the brightness value for their particular color for each pixel, and the three values combine to determine the actual color of each pixel.

- **Adjust HSL**: You may want to change the color of something that is widely dispersed throughout your image. For example, grass, leaves of trees or shrubs, sand etc. Since objects like grass or leaves typically contain a range of similar color, using the Hue/Saturation/Adjustment Layer is an ideal tool for selecting these objects and then applying your color correction.

- **Invert**: Allows you to invert one or more color channels.
- **Shift**: Allows you to shift one or more color channels
- **Swap**: This function allows you to swap color channels within the image.

- **Effects, Filters, Transforms**: Three group menus that group together the commands depicted in the graphics below. There are many commands to choose from to suit just about any image manipulation need. The best way to learn them is to experiment with them to see what ones will work best for purposes.
- **Flip**: This command will allow you to flip the image in any direction then create a mirror image of the original.
- **Rotate**: This command will allow you to rotate the image.
- **Resize Canvas**: This command will allow you to change the size of the image.
- **Resample**: This will allow you to refresh the image.
- **Crop / Auto Crop**: Using the rectangle selection or the ellipse selection this command will allow you to crop your images by using one of the selection tools and drawing a cutting fence and selecting Crop. Or, you can set it to auto crop so when you finish the selection area it will automatically crop the image.
- **Skew**: This will allow you to skew an image offsetting the top of the image from the bottom of the image.

**The EXIF Menu**

The EXIF menu contains commands that you can use to view or modify the EXIF data embedded with the image. This includes any special attributes stored in the EXIF, as well as the image’s geotagged coordinate information.

- The EXIF menu contains the following commands:
  - **Show**: By selecting this command, it will display the entire image EXIF data for you to view.
  - **Hide**: This will hide the EXIF data from view giving you more room to view the image.
  - **Edit**: This will display the EXIF Editor that allows you to edit data.
fields within the EXIF header.

**Imprinting Images**

1. Click on the Imprint Images button.
2. The Imprint Window will appear. The Imprint Window allows users of all skill levels to imprint text, logos, image EXIF tag data and more.
3. To imprint on images refer to the following:
   i. To imprint text with EXIF tags such as date and time, simply enter into the **imprint text box** “Date and Time” followed by the Date and Time EXIF tag “%DATETIME%.
   ii. To modify text already inserted simply click on the text box and make necessary changes.
   iii. To imprint a logo on your images click on the “insert picture button”. Then select your logo to place within the layout window. Then simply move the logo by dragging the item to the desired spot.

4. To imprint your images simply click “Imprint Image” on the image preview window. If you need to make changes to your imprinting, simply exit the Imprint Preview Window and return to the main Imprint Window for changes.
5. Once you have created an imprint layout that you like you can now save your layout for future use by clicking on the save imprint file on the Main Imprint Window.

**Generate Image-Integrated Feature Classes or ESRI® shp files**

Once you have loaded your images and preprocessed them as needed, you are ready to create a feature class or ESRI® shp file directly from these images. With Wind Image™ you can generate a feature class or ESRI® shp file that will incorporate and integrate your images into the ESRI® GIS system for viewing, mapping, and even analysis purposes.
How to Generate an Image-Integrated Feature Class or ESRI® shp file

1. Select the images you wish to include in the feature class.
2. Click on the Create button then Browse to the location where you wish to store the new feature class and enter a name for the new file.
   - Note: If you choose a folder for the destination, Wind Image™ will create a Shapefile. If you choose a Geodatabase, Wind Image™ will create a Geodatabase feature class.
   - Note: Shapefiles only allow you to link to images via a file path. Geodatabases allow you to embed the images inside the attribute table of the feature class (Recommended).

3. Set the output projection by clicking the browse button or leaving the default WGS 84 Lat/Lon projection.
4. Select the type of image integration you want, either Embedded (recommended) or Linked.
   - Note: Embedded is only available when creating Feature classes.
5. If you choose to link your images, and you want Wind Image™ to automatically rename them with a date and time identifier, or a custom identifier then check the corresponding check box.
   - Custom – You may only check this box after clicking the “Custom Rename” button and assigning the custom tag you want Wind Image™ to generate. (See Example right)
   - When using the “Custom Rename” option as shown in the example to the right you will enter the EXIF tags in the order you want the image renamed. (Example: %DATETIME%%RICOH1%)
   - Note: Doing this ensures that images copied into a common workspace do not overwrite each other.
6. If you choose to link your images, you must also select the radio button that indicates whether you want to copy or move the linked images.
   - By default Wind Image™ always places the images in the directory wherein the new or appended feature class or shp file exists. You may select another location to store the images by checking the box next to “To Specified Folder”.
7. Check the Create Border box if you want your images to have a border around them when displayed in your maps as a thumbnail.
8. Set the thickness and color of the border if you decide to include them.
9. In the **Offsets** box you will set the magnetic declination for your project area. The declination is the difference between magnetic and true north. This is important as most devices that give a compass direction give the direction as a magnetic measurement. And mapping programs use true north. To determine your declination click the calculate link. 
10. If you are using a laser device such as a LaserTechnology® TruePulse™ Laser and want to have the point locations set to your image target location check the “Offset based on Laser Device” box and set the default distance. 
11. Check the **Imprint** checkbox if you want to imprint information on top of the images, and then check the boxes that indicate the type of information you would like Wind Image™ to imprint. The options are: 
   - Date and time the photo was taken 
   - Latitude/Longitude where the photo was taken. 
   - Use Imprint File – You can ‘Browse’ for a saved Imprint File to use as a template or ‘Create’ one using the 'Imprint’ Screen and then save your layout as a template for future use. 

12. Choose the type of symbology you want Wind Image™ to assign when it loads the new or appended feature class as a layer in ArcMap®. 
13. Optionally, choose the field you want ArcMap® to rotate the layer symbols based on. 
14. Once you have made all of your selections, click on the create button to create or append to an Image Integrated feature class. 
15. Click **OK** if you would like to add the layer to your map. 

---

**How to Append to an Existing Image Integrated Feature Class**

1. To append to an existing Feature Class follow the “**How to Generate an Image-Integrated Feature Class**” instructions with the following exception. 
2. After you click on the **Create** button found in the Main Application window, browse to the feature class onto which you want to append new image records. (See example) 
3. Click “Save”. 
4. Configure the rest of the settings in the **Create** dialog box. 
5. Click **Create** to append the image feature records to the existing Feature Class.
**Import a Ricoh Tracklog or a Garmin GPX Waypoint File**

**About Importing a GPS Tracklog or a Garmin Waypoint File**

If you recorded a GPS tracklog or a Garmin Waypoint file while taking your photos, you can use Wind Image™ to quickly convert the tracklog or waypoint file into a feature class and load it into ArcMap®. In the case of the Tracklog the layer will then visually show you the path that you or others traveled while recording imagery in the field. If you import a Waypoint, it will now show up as a point in the layer.

(Note: Tracklog files from the Ricoh camera are stored on the SD card under the folder TRKLOG)

Wind Image™ creates one polyline and one point feature class for each Tracklog it processes. By doing so, it gives you the options to view your path as a series of points, as a line, or as both.

**How to Import a GPS Tracklog**

1. Click the import tracklog button
2. Browse to the tracklog file you want to import.
3. Browse to the workspace where you want to save the new feature classes and give them a root name.
4. Optionally, browse to change the output projection.
5. Click **Convert**.
Note: You cannot append to an existing feature class. You must create a new one when importing a new GPS tracklog or a GPX Waypoint file.

Tip: You can use the “DtTime” (Date/Time) field produced inside the output feature class table with ArcMap® Tracking Analyst to animate your tracklog path - requires the tracking analyst extension. See ArcMap® help system for Tracking Analyst.

How to Import a Garmin GPX Waypoint

1. Click the import tracklog/waypoint button
2. Browse to the waypoint file you want to import (gpx).
3. Browse to the workspace where you want to save the new feature class and give it a root name. Note that you can save it as a shape file by changing the ‘Save As’ type.
4. Optionally, browse to change the output projection.
5. Click Convert and add the layer to your map.
6. Now you will see the waypoint(s) from the .GPX file appear on your map layer.
7. For this demonstration, I changed the markers to Triangles and made them Red for visibility.

Dynamically View Images in ArcMap®

About Dynamically Viewing Images in ArcMap®

A key feature offered by Wind Image™ is an enhanced ability to dynamically view and map geotagged imagery. The main way it does this is with the Show Photo tool. The Show Photo tool can automatically display image thumbnails when you let your mouse pointer hover over an image feature point in ArcMap®. This means that you can conveniently see the image associated with an image point without a single mouse click.

As an added advantage, Wind Image™ also lets you access the Wind Image™ editor window so that you may continue to edit your images right from the ArcMap® map interface.

How to Dynamically View Images in ArcMap®

1. Click the Show Photo button.
2. Hover your mouse cursor over an image point. After a short time, an image thumbnail will appear.
3. Hover over another image point, and another thumbnail will appear.

Tip: You can change the size at which thumbnails display by the “Thumbnail Preview” settings under Wind Image™ settings found on the Wind Image™ menu located on the Wind Image™ toolbar.
How to Open Wind Image ™ Editor from the ArcMap® Interface

If you want to edit an image after processing, you can open the Wind Image ™ Editor window from a thumbnail view of an image.

1. Click the Show Photo button.
2. Hover your mouse over an image point and wait for the thumbnail to appear.
3. Double click the thumbnail image.
4. The Wind Image ™ Editor window will appear with the current image loaded and ready for you to edit.
   - Note: Wind Image ™ will save all edits to the linked images only; Wind Image will not modify the original image that existed in a different directory before processing. Images embedded in a feature class must be edited and saved prior to generating the feature class. Any edits made after processing will not be saved.

Map Your Images

Wind Image ™ can automatically place the dynamic thumbnails in a layer onto the map as graphics. Once placed, you can move, resize and further modify the thumbnails just like any other graphic in ArcMap®. You can use the graphic thumbnails to produce hardcopy and dynamic maps that highlight or otherwise take advantage of your field recorded imagery.

How to Convert Image Thumbnails to Graphics

1. Click the Show Photo button.
2. Hover your mouse over an image point and wait for the thumbnail to appear.
3. Right click on the thumbnail image.
4. Choose to Add to Layout and Wind Image ™ will add the current thumbnail to the map.

OR

5. Choose to Add All Images to Layout and Wind Image ™ will add all thumbnails in the layer to the map.

OR

6. Choose to Save As to save the image.

Tip: The graphic thumbnails will appear on the currently active annotation layer in ArcMap®. Make sure you choose or create the annotation layer you want the thumbnails to appear on before using Wind Image ™ to add them to the map.

Tip: Once you have add the thumbnails to the map as graphics, you can move, rotate, resize, and modify them the same way you can modify any graphic in ArcMap®. The example shows a thumbnail graphic with a shadow effect applied in ArcMap®.
**CartoPac® Integration**

**About Importing CartoPac® Data**
Another key feature offered by Wind Image™ is support for CartoPac® datasets. This gives the user the ability to convert and view CartoPac data sets in several different ways. One way to do this is with the **Show Photo** tool. You can also convert CartoPac® data to a Raster-Embedded data set using the ‘Feature Class to Raster’ tool as well as converting CartoPac® data to a Shape File – which also extracts the embedded data files to a folder.

**How to View Carto-Pac data sets using the ‘Show Photo’ tool**
1. Make sure that the ‘Show Photo’ button is turned on.
2. If you hover over a point with information embedded using CartoPac® software. If the point contains a data file – the following logo will appear instead of the usual image thumbnail. If the CartoPac® data point contains an image you will see the image thumbnail.
3. To view the CartoPac® data file, double-click on the logo.
4. To save the data file - right click on this logo, choose ‘Save As”, then simply pick an output location for the embedded file.

**How to Convert a CartoPac data-set to a Raster-Embedded data-set**
1. Select the ‘Feature Class To Raster’ tool under the Wind Image™ main toolbar.
2. Browse to your CartoPac® data set as the input, notice that the ‘CartoPac’ box is automatically checked.
3. Click on the ‘Browse’ button and select an output location for your Raster-Embedded data set and click ‘Ok’.

**How to Convert CartoPac data-set to a Shapefile**
1. Select the ‘Raster To Shapefile’ tool under the Wind Image™ toolbar (shown above).
2. Browse to your CartoPac® data set and select it as the input Feature Class.
3. Click on the lower ‘Browse’ button and select an output location for your Shapefile. Click ‘Ok’.
4. You will now find the embedded CartoPac® data files in the same output folder as your Shapefile.
Importing Data from ArcPad® or TerraSync®

About Importing ArcPad® or TerraSync® Data

This last section of the Wind Image™ manual deals with importing data from ArcPad® or TerraSync®. Functionally you will import the collected data with embedded pictures for use in your GIS Mapping projects using the ‘Feature Class to Raster’ tool. This is an easy way for your collected data and corresponding pictures to be imported into ArcMap®.

How to Convert Imported data to a Raster-Embedded data set

1. Select the ‘Feature Class To Raster’ tool under the Wind Image™ main toolbar.
2. Browse to your imported data set and select it as the ‘Input Feature(s)’.
3. You will now select an Image Field to use (one of the imprinted data fields within the image itself). For the purpose of this demonstration, I selected ‘Destination Bearing Reference’.
4. Click on the ‘Browse’ button across from the ‘Image Location’ box and locate the folder your imported pictures are in.
5. Next click on the ‘Browse’ button at the bottom and select an output location for your Raster-Embedded data and click ‘Ok’.
6. After the utility runs, click on ‘Yes’ to add the new layer to your map.
Additional Resources

For additional information on Wind Image™ visit
www.windenvironmental.com/windimage

Or
www.windimage.com

For additional information on ArcMap® visit
www.esri.com